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8 MORE ON DATABASE USE 
Manipulating the Data in the database 

 

LEARNING OUTCOMES 
Lesson 7 introduced you to the database concept in general, and to the Access database in 
particular. You learned how to plan a new database, how to set it up, how to add records, make 
changes to records, and delete records. You also learned how to save a database, and how to 
make backup copies. 

It is now time to start using those functions of the database that make it such a powerful tool 
for learning—for organizing data resulting from research, for helping you or your students to 
work on projects, for personalizing your interaction with students, and so forth. Some of the 
exercises cover aspects of database use—rules for finding and sorting records, for example—
which may be difficult for you to grasp. Forewarned is forearmed; put your thinking cap on! 

Lesson 8, then, after reviewing the basics, will introduce you to the following additional 
features of the Access database: 

• searching and querying a database 
• sorting records 
• creating reports 
• improving the report (making changes) 
• printing reports 
 

A caveat before you begin: You'll find it easiest to use the tutorial if you follow the directions 
carefully. On computers there are always other ways of doing things, but if you wander off on 
your own be sure you know your way back! 

 

8.1 GETTING STARTED 
What are the some of the advantages that electronic databases have over manual record keeping 
systems such as filing cabinets, folders, rolodexes, and the like? By the time you completed 
Lesson 7 you must have had a clearer idea of what a database is, and can probably now come up 
with an answer to this question. Here are a couple of the reasons frequently forwarded for using a 
database. Can you find your response among them? 

• One can store huge amounts of data in a small amount of space (on a 3 1/2" disk one can 
store about 500 pages of text, or over 7000 records, where each record might have up to 
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100 characters; on a zip disk you can store the equivalent of over 70 floppy disks; on a hard 
disk you can store the equivalent of dozens of zip disks, and so on); 

• One can easily manage all the data—view records, add new records, delete old records, or 
change existing records. You learned how to handle these tasks in Lesson 7. 

Here are some other reasons for using an electronic database. 
• One can quickly find anything one needs to know, and get answers to questions about the 

data in the database. What is Larry Dorey’s phone number? 
• One can home in on a small subset of the data. Which students have a GPA below 2.0? 
• One can instruct the computer to arrange (sort) records, and thus organize the data any way 

one likes. I'd like a listing with everything sorted based on the student hobby field. That'll 
make it easy for me to identify students who have the same interests. 

• One can use the computer to create any number of reports for the purpose of supplying 
others with information pertaining to the data in the database. My principal, Yvonne Singer, 
wants a monthly report of student progress in Reading, Writing, Math and Science. 

The purpose of this tutorial is to help you learn how to use the Access database in these last four 
ways. By the end of the tutorial you will have the basic skills you need to become a power user of 
the database. Whether you ever can call yourself a skilled user will depend, of course, on whether 
or not you continue to use Access as a tool to support your professional work in the classroom. 

Make sure you have your Office 2007 Work Files available on your 
computer, then open Access (Start > All Programs > Microsoft Office > 
Access 2007) 
Click on the Office button and choose Open (Fig. 8.1). 

 
Fig. 8.1 Office button 

Access will display the Open dialog box. 

Locate the Office 2007 Work Files folder on your disk and open it, then 
open the Access Files folder 

You are going to work first with a database similar to the one you created in Lesson 7. A 
document called Students 2007has been prepared for you. 



ESSENTIAL MICROSOFT OFFICE 2007: Tutorial for Teachers 
Copyright © Bernard John Poole, 2007. All rights reserved 

 

 248 

In the Access Files folder open the Students 2007 database (NOT the 
Student Database 2007database!) 
On the left side of the Access window, use the pull down menu to make sure 
the Forms object is selected (Fig. 8.2), then double click to open Student 
2007 Form 

 
Fig. 8.2 Selecting a Form or a Table 

You should see the Forms View of the Students 2007 database, as illustrated in Fig. 8.3. 

 
Fig. 8.3 The Forms View of the Students 2007 database 

 

8.2 REVIEWING THE BASICS 
You may not have worked with databases a great deal prior to using these tutorials, so it will be a 
good idea to start by recapitulating what you learned in Lesson 7 by way of reinforcement. Then 
you can move on to learn about the new features of the Access database that are targeted for this 
tutorial. Let's start with terminology. 

A database is a document which contains a set of records. Each record is made up of one or 
more fields, and each field may or may not contain entries. 

For example, a database of movie titles might have records for a few thousand movies. Each 
record will have fields for the movie title, the director, the producer, the star(s), and so on. A 
particular entry for the Movie Title field might be "Star Wars." 

Click here to pull 
down the 

Objects menu 
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Viewing the data in the database 
When you first open an existing database into primary memory, it is generally best to open a 
Forms View of the database because you can easily view the contents of an entire record on the 
screen, thus showing you what all the records basically contain. 

In the Forms View, as you can see, the data for one complete record is shown in the Form. 
Notice the database navigation tools at the bottom of the Form window (Fig. 8.4). 

 

 
Fig. 8.4 Navigation tools in the Access database 

Look them over now to re-familiarize yourself with how they work. 

Now, close the Students 2007 Form and, in the Objects menu in the left 
hand side of the database window, switch to Tables, and double click on 
Student Records Table 

This Datasheet view (Fig. 8.5) shows the records across the screen in rows and columns much 
like the Spreadsheets you learned to use in Lessons 4 and 5. 

 

Fig. 8.5 Viewing records in the Datasheet view 

Adding a record to the database 
You can add a new record any time you want, wherever you may be in the database, because you 
can tell Access to sort everything into a specific order whenever you need to do so. You will learn 
how to do this in a later section of this tutorial (8.4 SORTING RECORDS). You are going to 
add a couple of new records now. It’s easiest to do this in the Forms view of the database. 

Close the Students 2007 Table and, in the Objects menu in the left hand 
side of the database window, switch to Forms, and double click on Student 
Records Form 
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In the Records Group of the Home Ribbon, click on the New button (Fig. 
8.6) 

 
Fig. 8.6 The New button in the Records Group of the Home Ribbon 

This will open up a set of empty fields for the new record (Fig. 8.7) 

 
Fig. 8.7 Entering data for a new record 

Enter the data for this new record, and at least one other new record (two 
records in all), pressing the Tab key after you type the data for each field 

You can put any data in the records you are adding because you’ll delete them in a bit. You can 
even skip a field, if no data is required for that field, by simply pressing Tab without entering any 
data. 

Clearing a field in a record 
First you need to know that you cannot clear entries from a field that has been defined as 
requiring data of some kind in the field. If you try to clear data from these fields (in our database 
the First Name through the Home Contact fields, for example) you will get a warning prompt 
from Access telling you that you cannot have a null value in these fields. 

Use the navigation tools (Fig. 8.4 on previous page) to go back to the first 
of the records you added just now 
Click in the Nick Name field entry box (not on the field name) of the first of 
the records you added just now and highlight the data in the Nick Name 
field entry box, then from the Edit menu select Cut (ctrl-X) 
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Next go to the second of the records you added a moment ago, click in the 
Clubs field entry box and again select the data in the Clubs field, then from 
the Edit menu select Cut (ctrl-X) 

Notice that this does not delete the field or the record; it simply clears the selected entries in a 
field. The field is still there, so new data can be entered into it. 

Deleting (clearing) a record, or a set of records 

Use the Navigation tools to locate one of the records you just added, then 
In the Records Group of the Home Ribbon, select Delete Record 

Access immediately displays a warning dialog box (Fig. 8.8) to tell you that if you go ahead you 
will permanently lose the data in the record. 

 
Fig. 8.8 Delete Record warning prompt 

Click on Yes to delete the selected record 
Notice that this removes the record(s) entirely. 

Changing the data in a field 
Suppose some data gets entered incorrectly—through misspelling or a typo. Let's say you needed 
to update a nickname in a student's record. To change it you would do the following. 

Locate the record in which you want to make the change (for this exercise 
select any record you like) 
Click in the entry box for the field name that needs to be changed (use any 
entry in the Nick Name field for this exercise) 
Change it to some other nick name in the same way you would in a word 
processor 

All of the exercises in this section were by way of recapitulating what you learned in Lesson 7. 
Now let’s move on to learn some more advanced features of the Access database. 

 

8.3 SEARCHING AND QUERYING A DATABASE 
This is a powerful function of the Access database. You can find anything in the database if you 
know what to do. 

All you have to do is give Access any set of characters as the key for a search of the database, 
and the system will find that set of characters, if it exists, even if it is just a part (a subset) of a 
larger word or phrase. 
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There are several ways you can do this. But first you need to open another, larger, database onto 
the Access Desktop. 

Close the Students 2007database document and from the Office button 
menu select Open 

The disk containing your Office 2007 Work Files should still be in the drive. 

Open the Birds database (inside the Access folder of your Office 2007 
Work Files), then, in the Objects menu on the left side of the database 
window (see Fig. , open the BirdSightings Form (not the Table) 

Finding a single record using data from a specific field 
You often may need to locate and display the contents of one particular record, or set of records, 
based on data from one specific field. The function Find, which is in the Edit menu, is the Access 
command to do this. It works much the same as when you use the Find command in the word 
processor, which you learned about in Lesson 2. 

Suppose, for example, you wanted to find the record for the bird with the Common Name 
Northern Oriole in the Birds database. Here is how you do this. 

In the Find Group of the Home Ribbon click on the Find button (Fig. 8.9) 

 

Fig. 8.9 The Find (and Replace) Group 

Access now displays the Find and Replace dialog box (Fig. 8.10) 

 

Fig. 8.10 The Find and Replace dialog box 

You need to indicate what data you want found in the database by first identifying what part of 
the database you want Access to “Look In.” For this first search, we’ll tell Access to go look 
anywhere amongst the BirdSightings data. Also, you need to indicate if you want to match the 
data in a Whole Field or Any Part of a Field. 
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Click on the arrow to pull down the Look In: options and select 
BirdSightings, then click on the arrow next to the Match options and select 
Any Part of Field from the drop down menu 

The record(s) you find with a Find request are called the "found set". 

In the Find What: entry box type Northern Oriole (or northern oriole—if 
you don’t check the “Match Case” box, Access doesn't care whether you use 
upper or lower case letters) 

Now click on Find Next, then click on Cancel 

Access quickly locates the record containing the name "Northern Oriole." This one record alone is 
shown in the BirdSightings Form window. Of course, if you incorrectly typed Northern Oriole, 
Access would tell you that the search item was not found (Fig. 8.11). 

 
Fig. 8.11 Warning message after unsuccessful search of the database 

In the Views menu, select Datasheet View to see the records following the 
Northern Oriole record 

Finding two or more records based on data from a single field 
Next, let’s search on criteria which will find more than one record. You want to find any bird with 
the primary color (Color1) that has any shade of black in its plumage. 

Close (X out of) the BirdSightings datasheet table 

in the Views menu select Form View, then double click on the 
BirdSightings Form to open it, and click to put the cursor anywhere in the 
Color1 field 

Click on the Find button in the Home Ribbon’s Find Group (looks like a pair 
of binoculars), and type the word Black in the Find What: box 

Click on Find Next, then move the Find and Replace dialog box out of the 
way, if necessary, so you can see the contents of the record  

The search finds the first of 11 records where a bird in the database has the color “black” in its 
plumage. 

To see the data in the next record, click on Find Next again, and so on 

See if you can count 11 records of birds with the color black in the 
plumage? 

To see a listing of all the records that result from a search such as this, you must use a filter. 
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Filter by selection 
The exercise that follows will use a filter to select the set of birds whose habitat is “marshes.” This 
is best done in the Tables View of the database. 

Close the BirdSightings Form, and use the Objects menu if necessary (Fig. 
8.2) to switch to the BirdSightings Table  (Fig. 8.12) 

 
Fig. 8.12 The BirdSightings Table 

Scroll to the right to locate the Habitat column 

Now (and this is tricky, so stay focused) position the mouse arrow near the 
left edge of one of the marshes entries until the mouse pointer will become 
a hollowed-out plus sign ( )—and, when it does, click the mouse button 

This tells Access that you want the set of birds which lives among marshes. 

Check out the Home Ribbon and locate the Sort & Filter Group of tools 
(Fig. 8.13) 

 
Fig. 8.13 Sort & Filter Group 

Click on the Filter by Selection icon in the Sort & Filter Group (Fig. 8. 13) 

In the menu that pops up, select Equals “Marshes” 

Filter by 
Selection 

icon 



Lesson 8: More on database use 

 255  

You will now see a list of 15 birds in the database that live in marshes (Fig. 8.14). 

 
Fig. 8.14 The found set of filtered records 

Click the Remove Filter button on the toolbar (Fig. 815), or from the 
Records menu select Remove Filter/Sort to go back to viewing all the 
records in the database 

 
Fig. 8.15 Remove Filter button in the Sort & Filter Group 

Filter by Form 
You can filter records using a Form, too. In other words, you can select a set of records no matter 
what database mode you are in—a Table or a Form. Here’s how you do a Filter by Form. 

Let’s say you want to find all the records in which the birds have the color “black” or a 
combination of “black” and some other color in their plumage. 

Remove Filter 
icon in the Sort & 

Filter Group 
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In the Sort & Filter Group of the Home Ribbon click on the Advanced 
Filter Options icon and, in the drop down menu, select Filter by Form (Fig. 
8.16) 

 
Fig. 8.16 Access Advanced Filter Options 

Access presents an empty record for you to select the criteria for the filter (Fig. 8.17). 

 
 

Fig. 8.17 The Filter by Form window with its Look For and Or tabs 
But first you need to tell Access that the previous filter (for the birds that live among marshes) is 
no longer relevant. Access keeps previous search criteria active unless you remove them from the 
filter. So you need to remove "marshes" from the Habitat entry box. This is easy enough to do. 

Drag to highlight the “marshes” habitat, if it isn’t already highlighted, and hit 
the Backspace key 

Now you must do a Filter by Form using the Color1 field. You want to find all the birds that have 
either black, or blackish green or blackish blue in their plumage. 

 To do this, click in the data entry area below the column header of the 
Color1 field 

Advanced Filter 
Options icon 

Filter by Form 
option 
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You should now see a small down arrow at the right hand edge of the Color1 data entry box (Fig. 
8.18). 
 

 
Fig. 8.18 The drop down list of colors 

Click on the arrow on the right edge of the Color1 data entry box to see the 
list of the possible colors in the Color1 field (Fig. 8.18 above) 
Click on the color “black” in the list, then click on the first Or in the Look for 
filter rule icons at the bottom of the Filter by Form dialog box (Fig. 8.17) 

This will bring up a new, empty filter dialog box. 

In the Color1 field, click again on the arrow to see the list of possible 
colors and, in the drop down list, click on “blackish green” 

Now, click on the next Or in the Look for filter icons at the bottom left of the 
dialog box, then, once more, click on the arrow on the right edge of the 
Color1 data entry box 

In the drop down list click on “bluish black” 
That is all the colors in the Color1 field that have the color black in them. 

Now click on the Apply Filter button in the Sort & Filter Group of the Home 
Ribbon (Fig. 8.19) 

 
Fig. 8.19 The Apply Filter button 

Immediately Access filters out the set of birds with black in their plumage (Fig. 8.20). 

Click on this arrow 
to pull down the 
Color1 options 

Apply Filter 
tool 
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Fig. 8.20 The result of the color filter 

Searching based on criteria from more than one field 
This time you are going to give Access two or more search criteria for your search of the 
database. The system will search every field of every record, locating those records that contain 
the set of characters that make up the search criteria. Access will then display the complete 
contents of all the records that contain the data you’re looking for. 

Click on the Remove Filter icon in the Sort & Filter Group of the Home 
Ribbons 

 
Fig. 8.21 Remove Filter icon in the Sort & Filter Group 

It doesn't matter where you are in the database to begin the search. Access will always search the 
entire database for the records you request. For instance, let's say you want to find all the records 
for birds that you spotted in the month of September. You know there were several, but you don't 
remember which they were. Here are the steps you would follow to do this. 

First you need to remove any filters from a previous search because Access remembers them 
from search to search. 

In the Sort & Filter Group of the Home Ribbon click on the Advanced 
Filter Options icon and, in the drop down menu, select Filter by Form (see 
Fig. 8.16 above) 
Remove the “black” filter in the Color1 box by hitting the Backspace key 

Now hit the Or tab in the filter search expression (Look for) tools at the 
bottom left of the window 

Remove Filter icon 
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Hit the Backspace key to remove the criterion “blackish green”, click on the 
next Or, and hit the Backspace key to remove “bluish black” 

Now you are ready to create the new filter. 

First, click on the Look for tab in the lower left corner of the Filter by Form 
window, then scroll across if necessary to the Date Sighted field entry box 
immediately below the field name and click in it 

Click on the arrow that pops up to see the drop down list of all dates on 
which birds were sighted 

Click on the first date which has a ‘9’ for the month (September) 

After you click on it, you’ll see the first date in the entry box with ‘#’ symbols around it to 
indicate its selection by the filter. 

Click on the first Or tab, then click on the arrow in the Date Sighted box 
again and select the second date with a ‘9’ for the month 

Now click on the Apply Filter button in the toolbar 

Access quickly finds the set of records for birds sighted on the 1st or 8th of September. How many 
records did you get? There should be 12. 

 

8.4 SORTING RECORDS 
The three major advantages of an electronic data storage system such as a computer disk over a 
manual, paper-based filing system are 

1. the organizational flexibility (making change easy); 
2. the enormous reduction in the amount of room required to store all the data (saving 

space); 
3. the greatly increased speed of data access (saving time). 

When we use filing cabinets to store data we usually come up with some kind of organization. So 
we put labels on the drawers in the cabinets and labels on the folders inside the drawers. This 
organization is often based on numeric or alphabetic sequencing. The purpose, of course, is to 
enable us to quickly find what we have stored in the appropriate folder in the appropriate drawer. 

This is a good system as long as we have no cause to frequently change the organization we 
have set up, and assuming space and time are not at a premium in our day to day operations. 
Unfortunately, change, space, and time are factors critical to our productivity, so we should 
welcome any system which helps us cope with change and optimizes our use of space and time. 

Today, using state of the art technology, we can electronically store the equivalent of the 
Library of Congress in a shoe box. And we can now access any specific item in that "box" in a few 
thousandths of a second. What is more, software such as Access makes it possible for us to 
organize that data more or less on the fly by sorting it any which way we want. 
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Sorting on a single field 
Take, for example, the Birds database that is on your Desktop at this time. As you can see, the 
bird names (Common Name field) are not sorted in any particular order. In fact, the database is 
sorted based on the Date on which each bird was Sighted. 

So the ordering is chronological rather than alphabetical. It would therefore be difficult, 
especially if the database were very large, to visually find the record for a particular bird (which is 
why Access makes available the Go To Record, Sort Records and Match Records functions under 
the Organize menu). 

What if you wanted to print out a report listing all the birds in alphabetical order by name of 
bird? You would have to first organize the records alphabetically on the bird names. Fortunately 
Access has a Sort Records... function which enables you to complete this operation with the 
greatest of ease. 

First you need to remove the filter you used to select the set of birds sighted in September. 

Click on the Remove Filter tool in the Sort & Filter Group of the Home 
Ribbon 

You can best see the results of a sort if you are in the Datasheet view of the database, which is the 
view you should have on your screen. 

If you do not have the Datasheet View, select it now from the View menu in 
the Views Group before proceeding 

Click anywhere in the Common Name field, then click on the Sort 
Ascending button in the Sort & Filter Group of the Home Ribbon (Fig. 
8.22) 

 
Fig. 8.22 The Access Sorting tools 

Immediately Access sorts the records alphabetically on the Common Name field. There are other 
sorting options depending on the type of data in the field you are using as the basis, or key, for the 
sort: 

• If your sort request is based on a Text field such as Common Name or Location Sighted, 
the sort will be either Ascending (A to Z) or Descending (Z to A). 

• If you are sorting on a Number field such as the Count field, you would be able to sort in 
Ascending (Low number to high number) or Descending (High number to low number) 
order. 

• Finally, if you are sorting on a Date field such as Date Sighted, you would be able to sort in 
Ascending (Chronological) or Descending (Reverse Chronological) order.  

Sort Ascending Tool 
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8.5 CREATING REPORTS 
A word about the Access database reporting facility 

• Planning is still an important prerequisite for good report definition. No matter how 
tempting it might be, always resist creating a report without first thinking and mapping out 
what you want as the finished version of a report. 

• Changes you make to data fields for the report do not affect the data in the database at all. 
So you don't have to worry about losing data, or messing up the database when you create 
reports. 

• You can create reports that contain just a few fields from a selected set of records by using 
the search criteria techniques that you already learned about in this lesson. For instance, you 
could use the Birds database to print a report listing just the name, color, and count of birds 
that were seen in your neighborhood. Shortly you will practice doing something along these 
lines. 

• You can create numerous layouts or reports for a database, each report having different sets 
of data, and you can store them all along with the database. 

In the next sections you will continue to work with the Birds database. You are going to create a 
simple report.  

Initial definition of the layout or report 
You are going to create a layout or report format which will list all members of the duck and rail 
families sighted during the reporting period covered by the database. The fields in the report will 
include the Common Name, Family, Date Sighted and Count fields.  

A word about selecting tabular layouts 
Bear in mind that most databases have many fields. If there are more field names in a report layout 
than can fit across the screen or page, the names simply wrap around, creating two or more lines, 
if necessary, in the top section (the Header) of the layout. 

This can make for very untidy, not to say confusing, reports. The columnar report you are 
about to work with will not have this problem because you will be using only a small selection of 
the fields in the database (just 4 to be exact), but it is good to be aware of the problem should the 
occasion arise where you want to create a report that uses many fields. 

On with the show! 
You need to start by using a filter to create a new Table. You want to select only the birds in the 
Duck family for the Report. 

In the Sort & Filter Group of the Home Ribbon click on the Advanced 
Filter Options tool, then select Filter by Form from the menu 

Now click in the Family field entry box, just below the Family field name 

Next click on the arrow to see the drop down list of all possible families of 
birds and click on Duck, then click on the Apply Filter button in the Sort & 
Filter Group of the Home Ribbon 



ESSENTIAL MICROSOFT OFFICE 2007: Tutorial for Teachers 
Copyright © Bernard John Poole, 2007. All rights reserved 

 

 262 

Next, click on the Create Tab to show the Create Ribbon at the top of the 
Access window and, in the Reports Group of the Create Ribbon click on 
the Report Wizard tool (Fig. 8.23) 

 
Fig. 8.23 The Report object in the database objects drop down list 

You have to save the Table again before you can close it and move on to 
create the report, so click on Yes in the dialog box that pops up on the 
screen 

This brings up the Report Wizard dialog box (Fig. 8.24). 

 
Fig. 8.24 The Report Wizard dialog box 

Select the default Table: BirdSightings table as the source for the report’s 
data 
Then, in the Report Wizard dialog box, from the Available Fields: double 
click on the Common Name, Family, Date Sighted, and Count fields in 

Report Wizard 
Tool 



Lesson 8: More on database use 

 263  

order to move each of these four fields to the Selected Fields: box (Fig. 
8.25) 

 
Fig. 8.25 Selecting the fields for the report 

Now click on the Next button 
Access now asks you in a new dialog box if you want to add any grouping levels to the report. 

You don’t want to add any grouping levels, so click on the Next button to by-
pass this dialog box 

In the next dialog box you are asked if you want to sort the records. There is no need to do this 
since you already sorted them in Ascending Order based on the Common Name 

Click on Next once more to proceed to the next step in the Report Wizard 
The default setting for the report layout is Tabular, which is what you want. 

Click on the Next button, then select any style you like for the style of the 
report in the next dialog box (Fig. 8.26) and click on Next 

 
Fig. 8.26 The Report Wizard Style selector dialog box 
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In the next step of the Report Wizard you have to enter the title for the report (Fig. 8.27). 

 
Fig. 8.27 Entering the title for the report 

For the Title of the report, type Count of Ducks Sighted, then click on the 
radio button next to “Modify the report’s design” 

You need to select this option to modify the report’s design since, as you will see shortly, you 
need to rearrange the headers and fields so they fit nicely on the page of the report. 

Click on Finish 

 
8.6 IMPROVING THE REPORT (MAKING CHANGES) 
As you can see from Fig. 8.28 on the next page, the new layout which you named Count of Ducks 
Sighted needs some work. 

 

Fig. 8.28 The unmodified report in the Design View 
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After completing the following exercises, the report will look like Fig. 8.29. 

 
Fig. 8.29 Final version of the Count of Ducks Sighted report 

The Modify window for the report has five sections to it: a Report Header section, a Page Header 
section, a Detail section (where the data will be listed), a Page Footer and a Report Footer. 

In the Page Header section, the Common Name column needs to be widened so that the 
names of the birds will fit in the column. The space allowed for the Family column, however, is 
much wider than necessary. 

Click once on the Common Name Page Header to select the box for the 
field 
Now grab the right edge of the box—the right edge, not the left—and drag 
the edge of the box to the right to increase its width till it is about twice as 
wide as the header Common Name itself 

Click once on the Family Page Header to select the box for the field 

Now grab the right edge of the box—the right edge, not the left—and drag 
the edge of the box to the left to reduce its width till it is about the same 
width as the word Family itself 

Notice that the Family box in the Detail section of the report also is reduced in size. 

The Date Sighted Page Header and the Count header are fine as is 
Your last task is to center the report title. 

Click on the title Count of Ducks Sighted 
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Position the mouse arrow along the lower edge of the box till the arrow 
changes to a crosshair icon, then drag the title to the right a little till it is 
centered over the columns of the report 

When you are done, the Design View for the report should look like Fig. 8.30. 

 
Fig. 8.30 The final Design View of the report after modifications 

From the View menu select Print Preview to check out how your report will 
look when you send it to the printer. 

It should look similar to that illustrated in Fig. 8.29. 

If you need to go back and do further modifications to the report, just go back 
to the View menu in the Views Group of the Home Ribbon and select 
Design View 
 

8.7 PRINTING REPORTS 
Once you have prepared the new report, it is a straightforward process to print the report. The 
command to do this is the same as you have used to print any other documents from within 
Microsoft Office, whether you have been working in Word Processing or the Spreadsheet. 

You should still be in the Print Preview window, so click on the Print button 
at the top left of the Print Preview window to print the Count of Ducks 
Sighted report 

Remove the report from the printer and take a closer look at its contents. Notice that the only 
records in the report are those relating to ducks in the Family field. These are just a small subset 
of records drawn from the larger Birds database.  

 

LOOKING BACK 
The Access database is a sophisticated tool for managing data. The key to success, as in so many 
activities, is PLANNING. Computers are wonderful tools to assist us in our professional lives, but 
only if we bring our intelligence to bear. The more skillful the user, the more powerful the impact 
of the computer on our professional and non-professional productivity.  
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You practiced three important skills of database management in this tutorial: 
1. You learned how to search and query a database so that, no matter how large it might be, 

you could easily and quickly get the answers to any questions you might have. Getting 
answers to questions, research and so forth, is what creating electronic databases is all 
about. 

2. You learned how to sort a database, and select out subsets of records. 
3. You learned how to create and print new layouts or reports based on the data in a 

database. 
Perhaps you have already learned about the value of database management systems such as 
Access in the educational process. Databases are the electronic storage bins for knowledge. Today 
they are both local and global in scope. More and more data is becoming available for on-line 
research. In time, maybe 50 years from now, maybe less, all knowledge will be accessible 
electronically. In the meantime, as teachers we should become aware of just what is available to 
our students, and do what we can to educate them to take advantage of information services of all 
kinds. 

The role of teachers is changing. We are no longer the source of all knowledge. Rather, we 
are "knowledge brokers," intermediaries between our students and the source of the data they 
need so that they can "grow in wisdom and knowledge." As someone has observed, "Teachers 
should move away from being sages on the stage, and become, instead, the guides at the side." 

 

LOOKING FORWARD 
There is more to learn about the Access database. It is beyond the scope of this book to cover all 
of the features of the software. However you have certainly learned the fundamentals and have the 
tools now to make a database work for you and for your students. The exercises that follow in the 
SKILL CONSOLIDATION section will help you reinforce the knowledge you have gained. 

"Practice makes perfect" is as true of computer use as it is of any other skill-based activity like 
playing tennis or baking a cake. So is that other saying: "Use it, or lose it." You can probably 
identify many examples from your own experience where skills you were once proud to have 
mastered have become 'rusty' for lack of use. Likewise, you will quickly forget what you are 
learning in these tutorials unless you resolve to continue to apply the lessons learned on a regular 
basis, either for your own work or in the context of the classroom. 

The best teachers will use all the help they can get. The purpose of these tutorials continues to 
be to sharpen your skills in the use of one of the most powerful classroom tools yet devised—the 
electronic computer. You are to be congratulated for having persevered thus far. The remaining 
two tutorials will help you integrate the skills you have learned, and hopefully spur you on to a 
commitment to continue to incorporate the computer into your professional life both for your 
own sake and for that of your students. 

 

SKILL CONSOLIDATION 
Complete as many of these exercises as you can to reinforce what you learned in Lesson 8. 
1. Work with a group of your colleagues or classmates to specify and create a series of reports 

to accompany a database of student data such as the Roster Template database that you 
created in Lesson 7. Save the template with the set of reports. 
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2. Open the Fall Roster 2007 database onto the Desktop. 
• Add a record 
• Change the address and phone # in an existing field 
• Arrange the records chronologically on date of birth 

3. Create a new database (do not use a database you already created) on any topic of your 
choosing. 
• Design the fields (at least 10) to be included in the database 
• Save the empty database document 
• Add at least 20 records 
• Save the database document again 
• Prepare a report using just 5 of the fields in the database 
• Save the database with the report and send the database to your professor as an attachment 

in email 
4. Open the Birds database (in the Practice folder on your Work Disk) onto the Desktop. 

• Find all the birds that are blue and white 
• Find all the birds that have orange in their plumage 
• Arrange the birds in descending order (reverse alphabetical order—from Z to A) 

5. Complete the following exercise which will give you the opportunity to reinforce your 
understanding of Mail Merge and the Access database software. First, open a new database 
and name the database Missing Mystery.accdb 

Next, use the Design View to create a Table with the following 14 fields in it (but don’t have a 
primary key when you are asked if you want one).  Name the Table Missing Mystery Table. 
 

Noun 
Adjective (person’s appearance) 
Teacher’s Name 
Adjective (Number) 
Girl’s Name 
Adjective (color) 
Boy’s Name 

Adjective (size) 
Adjective (any) 
Adjective (feel) 
Noun (furniture) 
Adverb 
Another adjective (any) 
Noun (object) 
 

Now create a Form for the database and call the Form Missing Mystery Form. Type at least 5 
records into the database. 

Finally, type the following story into a Word doc called Missing Mystery Madlib.docx, using 
the Mail Merge Wizard to merge the document with the Missing Mystery.accdb database. Where 
you see << …>> is a merge field from the database. 

 
The Mystery of the Missing «Noun» 

 
 Yesterday I looked in my «Adjective_looks» desk to find my «Noun», but it wasn’t 
there.  I told my teacher, «Teachers_Name», and she said that «Adjective_number» 
students could help me look for it. «Girls_name» thought she found it, but it turned 
out to be a «Adjective_color» toy.  «Boys_Name» thought he saw it on the 
«Adjective_size» bookshelf, but it was someone’s «Adjective» «Noun_object» .  
Finally, I found it under the «Adjective_feel» «Noun_furniture».  We all cheered !  I 
will be sure to put it in a «Another_adjective» place next time. 


